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Conversion de données géométriques en modeles physiques de thermique
du batiment

La consommation énergétique d’un batiment a un impact direct sur le cout en énergie et sur 'environnement. La

plateforme Ktirio a pour but d’estimer différents parametres au moyen de simulations qui permettront de valider des
plans de construction ou de rénovation.
Afin de réaliser la simulation, il faut créer un fichier ayant le bon format contenant les informations nécessaires: architecture
du batiment, matériaux, lieu. Ces informations proviennent principalement des fichiers exportés depuis les logiciels de
CAO. L’objectif est de pouvoir manipuler de tels fichiers pour y ajouter d’éventuelles informations complémentaires et les
convertir en fichiers utilisables pour la simulation sans perdre d’information pour obtenir des résultats précis. L’outil
de conversion de fichier doit étre suffisamment robuste pour traiter correctement les géométries complexes présentes
dans D'architecture des batiments et les éventuels défauts de conception dans le logiciel de CAO. Des outils d’analyse
doivent étre créés afin de contréler I'intégrité des informations et des tests doivent étre mis en place pour vérifier le bon
déroulement de la conversion.

Avant d’apporter des modifications a 'outil open-source utilisé pour convertir les fichiers, il faut s’assurer que
Iinstallation de tous les outils est correcte grace a des tests automatiques et des fichiers de référence.
Un pré-traitement des fichiers exportés depuis les logiciels de CAO est utile pour ajouter les propriétés thermiques des
matériaux. Il faut alors créer de nouveaux fichiers de référence.
Différents outils de diagnostics sont utiles pour vérifier le bon fonctionnement de la conversion. Ils ont pour but de faciliter
l'acces aux informations contenues dans les fichiers complexes issus des logiciels de CAQ. Il est alors possible d’analyser
rapidement le contenu d’un fichier et de le comparer avec un fichier exporté différemment ou un fichier converti.

Développer un outil de conversion de fichiers contenant des structures géométriques complexes ainsi que des propriétés
physiques importantes est un travail de recherche ou la méthode, la rigueur et la maitrise des outils a disposition sont
nécessaires.
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Converting geometric data into physical building thermal models

Proper energy managment in a building can lead to less energy cost, fewer impact on the environnement and an overall
improved confort. Thermal simulation can be used to study a building before its construction or renovation.
Within Ktirio Project, building’s architecture, materials and location have to be stored in a specific structured file in
order to perform simulation. These data are exported from CAD software in large structured files.
The goal is to develop a tool able to analyse, modify (adding additional data) and convert these files into files usable for
accurate simulation, without loosing or overlooking any data. The tool has to be reliable enough to support building’s
complex geometry data and potential design flaws in CAD software. Analysis tools need to be created in order to control
data integrity and various tests have to be set up to ensure the accuracy of the conversion.

Before any modification to the open-source tool used to convert files, a serie of tests on multiple reference files have to
be performed to ensure the installation of all required tools was successful.
Files exported from the CAD software can be pre-processed and additional data such as materials’ thermal properties can
be inserted. At this stage a new set of reference files is created.
Analysis tools can be used to check if the conversion was successful. They have to facilitate access to data contained in
complex files and allow to perform quick and precise comparison between files, either CAD files exported differently or a
CAD file and the result of the conversion.

Developping tools to analyse and convert files containing highly detailed geometric structure and their thermal porperties
is a long process that require methodology and mastering a wide set of tools.
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1 Introduction

1.1 Cemosis

Le Centre de Modelisation et de Simulation de Strasbourg (Cemosis)[3], fondé en 2013 par Christophe Prud’homme,
est spécialisé dans les domaines de la modélisation, la simulation, I’optimisation et le calcul de haute performance.
Hébergé par I'Institut de Recherche Mathématique Avancée (IRMA), Cemosis a été créé dans le but de répondre a des
problématiques multidisciplinaires a 1’aide d’outils de simulation et de modélisation, de proposer des formations ainsi que
d’établir un lien entre acteurs de la recherche, PME/PMI et grandes entreprises de la région Alsace.[4 [5 [24]

[]
L]
[]

S|

Centre de modélisation et de simulation de Strasbourg

Cette plateforme de collaboration, regroupant moins de cinquante employés répartis dans les locaux de 'UFR (Unité
de Formation et de Recherche) de mathématique et d’informatique de Strasbourg, s’engage dans différents types de
projets:

e Projets a court terme utilisant principalement des outils déja développés.

e Projets nécessitant le développement ou ’adaptation d’outils pour traiter des modeles existants, réalisés par un
ingénieur ou un postdoctorant recruté pour une durée allant jusqu’a deux ans.

e Projets d’une durée minimale de trois ans, généralement associés & une convention CIFRE (Convention Industrielle
de Formation par la Recherche[25]), ayant pour but de créer les modeles et les logiciles nécessaires.

Les projets actuellement en développement sont majoritairement liés au domaine de la santé (AngioTK, Vivabrain,
Eye2Brain) et de 1’énergie (Tonus, Ibat).[6]

Projet [

Cemosis ‘ Laboratoire ou entreprise ‘

!
|
Recrutement |
|

Y
’ Ingénieur ou postdoctorant ‘

Figure 1: Organigramme d’un projet Cemosis

1.2 Contexte

En 2021, pres de la moitié de ’énergie consommée en France était liée au secteur du batiment, émettant plus de
123 millions de tonnes de CO2 [23]. De nombreux béatiments souffrent d’une mauvaise isolation ou d’un systeme de
chauffage/rafraichissement inadapté engendrant des pertes énergétiques. Afin de limiter le gaspillage il faut concevoir ou
rénover un batiment dans le but de minimiser les pertes.

Réaliser une simulation en prenant en compte ’architecture (forme du batiment, taille des pieces, etc.), les matériaux
(isolation, ouvertures, etc.) et Pemplacement (exposition au soleil, climat, etc.) permet d’estimer les perfomances
énergétiques du batiment.

Mémoire de stage de 18" année 1 September 10, 2022
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Figure 2: Simulation thermique d’un batiment par Cemosis [26]

1.3 Projet Ktirio

Le projet Ktirio a pour objectif de créer une plateforme en ligne permettant le suivi en temps réel, la simulation et la
prédiction a court, moyen et long terme ainsi que ’analyse du comportement thermique, du confort et de la performance
énergétique de batiments.

La plateforme permettra de suivre et de simuler le comportement thermique d’un batiment. Pour cela, elle integre des
outils qui permettront de faciliter et robustifier les différentes étapes d’une analyse énergétique, allant de la génération
automatique de modeles a partir de la géométrie 3D a la production d’indicateurs de confort et de performance utiles a la
prise de décision quant a la gestion et la rénovation du batiment.

Cet outil interactif permettra de visualiser de fagon précise un batiment et ses composants (position, caractéristiques
et propriétés thermiques des éléments de construction), de définir les zones thermiques (regroupements de pieces ayant les
mémes propriétés thermiques) et d’effectuer des simulations sur un batiment.

Gréce a un ensemble de capteurs répartis dans la construction, il sera aussi possible de suivre en temps réel I’évolution de
nombreux parametres thermiques et de confort.[24]

Les données géométriques et les propriétés thermiques (lorsqu’elles sont renseignées) du batiment sont automatiquement
extraites du fichier exporté par un logiciel de CAO et tansmises a un générateur automatique de modele qui permet de
créer les fichiers nécessaires a la simulation. Si les propriétés thermiques ne sont pas renseignées dans le fichier issu du
logiciel de CAO alors elles doivent étre importées avant de réaliser une simulation.

Le logiciel de CAO utilisé doit offrir la possibilité d’exporter au format IFC. Ce format fait partie du BIM, un ensemble
de normes internationales, européennes et francaises qui sont de plus en plus répandues dans les domaines du génie civil,
des travaux publics, des infrastructures et des réseaux. (voir section page @

1.4 Objectifs

L’objectif est d’assurer le bon traitement des informations afin d’obtenir des résultats de simulations corrects.
Pour cela, il faut:

e Développer des outils permettant d’analyser les fichiers sources.

e Accélérer et fiabiliser la saisie des données géométriques et des propriétés thermiques qui peuvent étre laborieuses et
sujettes a erreur.

Etudier et améliorer le générateur automatique de modeles.

Développer des outils permettant d’analyser les fichiers créés.

e Créer des tests permettant de vérifier le bon fonctionnement des modeles pour la simulation.

Mémoire de stage de 1°® année 2 September 10, 2022
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1.5 Organisation

Le projet est entierement géré sur GitHub, ce qui offre de nombreux avantages. La gestion des versions et le travail en
équipe est simplifié grace au travail en ligne. La mise en évidence et la gestion des modifications a apporter est rendue
efficace grace aux Issues et aux Actions. La gestion globale du projet peut étre faite en temps réel et de facon collective au
moyen de 'onglet Projects.

) sechorumro Pull requests Issues Marketplace Explore

& feelpp/ ktirio.dashboard >

ues (13

I Fabieninternship

Figure 3: Onglet Code de l'interface en ligne de GitHub

Le framework Pytest (voir section page [7]) est configuré dans le fichier pytest.ini dans le répertoire principal.
Ainsi, les tests Python ayant la bonne syntaxe sont exécutés automatiquement sur GitHub grace a I'intégration continue
mise en place dans les fichiers .github/workflows/ci.yml.

Les résultats des tests sont visibles dans la section Actions du panneau de controle GitHub.

Failure

Annotations

pytests

Figure 4: Onglet Actions de l'interface en ligne de GitHub

L’organisation au sein de I’équipe repose sur une bonne communication au quotidien grace a des rencontres dans les
bureaux ou des discussions via Slack (voir section page .
Une réunion Zoom (voir section page[8) a lieu chaque lundi matin afin d’organiser la semaine, présenter les derniers
résultats et répondre aux questions.

Mémoire de stage de 1°'¢ année 3 September 10, 2022
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2 Présentation du projet

Les données relatives au batiments peuvent provenir de différentes sources. L’outil permettant la simulation nécessite des
fichiers contenant toutes les informations utiles dans un format prédéfini. Le but est de collecter toutes les informations
disponibles dans le fichier source et de les transférer dans un fichier utilisable pour la simulation.
2.1 Conversion de fichiers
De nombreux facteurs sont importants lors de la simulation énergétique d’un batiment:

e Architecture du batiment (dimensions, formes, liens entre les différentes zones).

e Propriétés thermiques des matériaux.

e Localisation (climat et exposition au soleil).

e Systeme de chauffage/rafraichissement.

Pour récupérer les informations sur ’architecture, il est possible d’utiliser les plans créés par ’architecte dans un
logiciel spécialisé comme Revit ou ArchiCAD. Les plans sont récupérés au format IFC: un format de fichier standardisé
afin de pouvoir échanger des informations entre logiciels.

Remarque || Les fichiers utilisés dans le projet suivent la norme IFC2X3.
Cependant la simulation finale n’est pas exécutée sur les fichiers IFC. Il faut convertir les fichier IFC en fichier FMU.

Architecture Simulation thermique
.ifc Jfmu

Figure 5: Objectif de conversion

La conversion se déroule en deux étapes:
e Conversion du fichier IFC en fichier Modelica.

e Conversion du fichier Modelica en fichier FMU.

Architecture Fichiers Modelica Simulation thermique
Jife .mo fmu

Figure 6: Conversion en deux étapes

La premiere partie utilise 'outil de génération automatique de modeles a partir de templates CoTeTo et la librairie
Modelica BuildingSystems. Pendant cette étape l'entiereté de la structure du batiment est transférée dans un fichier
Modelica.

La deuxieme étape est réalisée par le logiciel Dymola.

2.2 Détails de la conversion en fichier Modelica

Les fichiers IFC ont une sctructure particuliere qui respecte certaines normes. La librairie Python IfcOpenShell permet
d’analyser ces fichiers de fagon efficace.

La librairie Modelica BuildingSystems définit les objets nécessaires pour décrire un batiment dans Modelica. Cette
librairie permet de réaliser des simulations énergétiques, notamment sur les modeles multizones utilisés dans Ktirio.
BIM2Modelica est un template pour générer automatiquement des modeles suivant les spécifications de BuildingSystems.
BIM2Modelica repose sur ’outil open-source CoTeTo.

Mémoire de stage de 18" année 4 September 10, 2022
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Conversion

IfcOpenShell
(Analyser IFC)

Architecture Fichiers Modelica
BuildingSystems mo

(Template)

.ife

CoTeTo
(Générateur de fichier)

Figure 7: Conversion des fichiers IFC en fichiers Modelica

2.3 Matériaux et propriétés thermiques

Les propriétés thermiques des matériaux n’étant pas toujours contenues dans les fichiers IFC utilisés, il faut ajouter une
étape de pré-traitement des fichiers IFC pour y ajouter ces propriétés.

Architecture

.ifc \
Architecture

et propriétés thermiques

Propriétés thermiques | — | ifc

des matériaux
.json

Fichiers Modelica Simulation thermique
.mo fmu

Figure 8: Pré-traitement et conversion des fichiers IFC

2.4 Géométrie et éléments de construction

11 existe différents logiciels de CAO utilisés pour concevoir des batiments. Chaque logicel présente des fonctionnalités
différentes pour la conception et pour 'exportation. Les fichiers IFC obtenus ne contiennent donc pas systématiquement
les mémes données et les mémes structures. Il est aussi possible de rencontrer des erreurs de conception dans les fichiers
exportés (collision entre deux éléments, mauvaise définition des zones thermiques).

Il faut donc étre capable de choisir les bons parametres d’exportation et de corriger les erreurs de conceptions lors de la
conversion.

Modifier la configuration x
<In-Session Setup> Général | Contenu supplémentaire | Jeux de propriétés | Niveau de détail | Avancé
<IFC2x3 Coordination View 2,0 Configuration>
«<IFC2x%3 Coordination View Configuration> Version d'IFC URee L= == N
<IFC2x3 GSA Concept Design BIM 2010 Configy| Type de fichier \EC -
<IFC2x3 Basic FM Handover View Cenfiguratior|
<IFC2x2 Coordination View Configuration> Phase & exporter Nouvelle construction M
<IFC2x2 Singapore BCA e-Plan Check Configurg]
<IFC2x3 COBie 2.4 Design Deliverable Configur{  Limites d'espaces 2éme niveau (]
<IFC4 Reference View Configuration>

Base des coordonnées Point de base du projet -

<IFC4 Design Transfer View Configuration>

IFC4 Reference View 1 R
Scinder les murs, les poteaux et les gaines par niveau

Inclure des éléments en acier s =
| Informations sur I'en-téte de fichier.. ‘

| Adresse du projet... ‘

Figure 9: Fenétre de parametre d’exportation au format IFC dans le logiciel Revit
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3 Outils

3.1 Normes et standards

BIM:
Building Information Modeling (BIM) est le processus global de création et de gestion
des informations pour une ressource de construction. Le BIM intégre des données
Buildin ginfo rmation structurées et pluridisciplinaires pour produire la r.eprés.ente\Ltion numér.ique d’une
ressource tout au long de son cycle de vie, de la planification a la conception et de la
% M O D E L LI N G construction a ’exploitation.
’ La norme ISO 19650-1 donne la définition suivante:
”utilisation d’une représentation numérique partagée d’un actif bati pour faciliter les
processus de conception, de construction et d’exploitation et former une base fiable
permettant les prises de décision.”

IFC:

88 Norme: IFC2X3

Le format IFC (Industry Foundation Classes) est un format de fichier standardisé
(norme ISO 16739) orienté objet utilisé par 'industrie du batiment pour échanger et

partager des informations entre logiciels.

3.2 Langages de programmation

Python:
Version: 3.8.13

ﬁ pg‘tl"l()r]TM Python[I4] est un langage de programmation interprété, multi-paradigme et

multiplateformes valorisant la programmation impérative structurée, fonctionnelle et
orientée objet.

/ ’ ’ J Modelica:

® Modelica[IT] est un langage de modélisation pluridisciplinaire qui supporte différents
M 0 D E L I c A types de formalisme. Modelica peut étre utilisé pour modéliser des systemes discrets
et continus de différentes natures a l’aide des librairies standard multi-domaines.

3.3 Environnement Python

AW
i Anaconda:
‘é. Anaconda[l] est un gestionnaire open-source de paquets et d’environnements,

disponible sur Windows, macOS, and Linux pour le langage Python en particulier.

ANACONDA

Mémoire de stage de 18" année 6 September 10, 2022
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3.4 Biblioteques Python

[™ pytest

IfcOpenShell:

Version: 0.6.0b0

IfcOpenShell[I0] est une librairie open source qui permet de manipuler des fichiers au
format IFC.

IfcOpenShell utilise Open CASCADE pour convertir la géométrie des fichiers IFC
dans un format utilisable par tous les logiciels de CAQO.

PythonOCC:

Version: 7.5.1

PythonOCC[12] est un wrapper Python pour OpenCASCADE C++.

Open CASCADE Technology (OCCT) est une librairie de géométrie 3D open source
qui permet de modéliser et visualiser des esquisses géométriques, des surfaces et des
solides tout en assurant une large compatibilité de formats de fichiers pris en charge.

Pytest:

Version: 7.1.2

Pytest[I3] est un framework de test logiciel basé sur le langage de programmation
Python. Il peut étre utilisé pour écrire divers types de tests logiciels, notamment
des tests unitaires, des tests d’intégration, des tests de bout en bout et des tests
fonctionnels.

Xlsxwriter:
Version: 3.0.3
Xlsxwriter[21] est un module Python permettant de créer des fichiers au format xlsx.

3.5 Biblioteques Modelica

3.6 Outils de CAO

SOLIBRI

Mémoire de stage de

1ére

année

BuildingSystems:

BuildingSystems[2] est une librairie open-source développée pour la simulation
énergétique de batiments & différentes échelles (pieces, batiments, quartiers...).
Cette librairie permet de réaliser des simulations énergétiques sur les modeles
multizones utilisés dans Ktirio.

Solibri:

Solibri[I7] Anywhere est un outil permettant de visualiser les fichiers IFC. Son
utilisation se veut simple, rapide et efficace pour les professionnels qui recherchent a
trouver des informations précises et pertinentes sur le batiment en construction.
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AUTODESK

REVIT

3.7 Outil de simulation

Dymola

3.8 Utilitaires

GitHub

a2 slack

Z00m

Mémoire de stage de

1ére

année

Revit:

Revit[I5] est un logiciel de conception de batiment édité par la société Autodesk qui
permet de dessiner un modele en 3D d’un batiment afin de créer divers documents
nécessaires & sa construction (plans, perspectives, ...).

Revit a la particularité d’étre un logiciel BIM multi-métiers destiné aux professionnels
du BTP (ingénieurs, architectes, dessinateurs-projeteurs, entrepreneurs, ...).

Les fichiers au format IFC sont nativement supportés par Revit. Il est possible de
visualiser le contenu du fichier de différentes fagons (2D, 3D, coupes, filtres...) et d’y
apporter des modifications.

Dymola:

Dymolal§] (Dynamic Modeling Laboratory) est un outil de modélisation et de
simulation de systemes intégrés et complexes, destiné a étre utilisé dans les secteurs
de 'automobile, 'aéronautique, la robotique, les processus et d’autres applications.
Dymola est basé sur le langage de modélisation Modelica.

CoTeTo:

Code Templating Tool[7] (CoTeTo) est un outil pour la génération de code source ou
texte provenant de sources différentes a ’aide de templates. Cet outil fonctionnant
par interface graphique, ligne de commande ou module Python peut étre modifié et
ameélioré pour satisfaire les besoins d’un projet.

L’outil Bim2Modelica développé par Cemosis est un template pour générer
automatiquement des modeles suivant les spécifications de BuildingSystems.

GitHub:

GitHub[9] est un service web d’hébergement et de gestion de développement de
logiciels, utilisant le logiciel de gestion de versions Git. Le site assure également un
controle d’acces et des fonctionnalités destinées a la collaboration comme le suivi des
bugs, les demandes de fonctionnalités, la gestion de taches et un wiki pour chaque
projet.

Slack:

Slack[16] est une application de messagerie pour les entreprises. La communication
repose sur un systéeme d’espaces de travail dédiés appelés canaux, qui rassemblent les
personnes et les informations pertinentes.

Zoom:
Zoom[22] Vidéo Communications est un service de conférence & distance qui combine
la vidéoconférence, les réunions en ligne, le chat et la collaboration mobile.
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4 Vérification de ’installation

La premiere étape pour commencer le projet consiste a installer et vérifier la bonne installation des divers outils.

4.1 Génération de fichiers

Une fois les outils installés (voir section [8] page [22), il faut vérifier leur bon fonctionnement. Pour cela, deux jeux de
fichiers de référence sont donnés dans le dépot BIM2Modelica: UdKb_Unit_Test_Cases et SBT_Unit_Test_Cases. Dans
IFC/IFC2X3, ce sont les fichiers au format IFC. Ces fichiers ont été convertis en fichiers Modelica avec BIM2Modelica dans
ModelicaModels/IFC2X3. Pour vérifier I'installation, il faut effectuer la conversion des fichiers IFC donnés et comparer
les résultats aux fichiers Modelica donnés.

Script de génération: Le script Python BIM2Modelica/tests/generate_reference.py permet de générer ces fichiers
dans BIM2Modelica/tests/ModelicaModels_reference avec les options souhaitées. La fonction config permet de créer
une copie du fichier Package.inf dans un répertoire temporaire en modifiant les parametres nécessaires. 1l faut ensuite
spécifier a 'outil de génération automatique de modeles d’utiliser ce fichier lors de son initialisation de la fagon suivante:

gen.init (packagePath = os.path.realpath(os.path.dirname( __file__)) + " /tmp")

Script de test On peut aussi créer un script qui permet de tester si de nouveaux fichiers générés coincident avec les
fichiers de référence. De cette fagon, il est possible de repérer s’il y a des différences entre les fichiers de référence et les
fichiers générés, révélant une mauvaise installation.

Conversion
IfcOpenShell
(Analyse IFCc)
Architecture Fichiers Modelica Pviost FlChler? Modellca
fe BuildingSystems mo 4’@‘; de référence
(Template) .m0
CoTeTo Installé CoTeTo correctement installé

(Générateur de fichier)

Figure 10: Protocole de vérification des fichiers générés

Le pytest BIM2Modelica/tests/check_ifc2Modelica.py génere de nouveaux fichiers dans un dossier temporaire
de fagon similaire au script BIM2Modelica/tests/generate_reference.py puis compare chaque fichier généré avec le
fichier référence qui lui est associé grace a la fonction compareFiles. Cette fonction compare le contenu des deux fichiers
ligne par ligne a I’exception de la quatrieme ligne qui est ignorée car elle ne contient pas d’informations importantes si ce
n’est la date de génération du fichier. Ci-dessous la boucle principale de la fonction compareFiles:

with open("tmp/” + mo_files_list[i], 'r') as generated, open(mo_expected_files_list[i],
'r') as expected:
generated_content = generated.readlines ()
expected_content = expected.readlines ()
for j in range(len(generated_content)):
if generated_content[j] != expected_content[j] and j != 3:
print("tmp/” 4+ mo_files_list[i] + " and " 4+ mo_expected_files_list[i] + "
are different line ", j)

return False
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Etude d’un fichier incorrect: Lors des premiers tests, un des fichiers de référence (BIM2Modelica/IFC/IFC2X3/
UdKB_Unit_Test_Cases/RooftopBuilding4Zones_Thin.ifc) engendrait une erreur de segmentation.

A ce stade, une erreur provient soit de loutil (erreur lors du développement, incompatibilité suite & une mise & jour, etc.)
soit de I'installation de ’outil. Il faut donc comprendre d’ou provient I’erreur pour s’assurer qu’elle ne provient pas de
I'installation.

Débogage: Une premiere approche pour localiser I'erreur consiste a ajouter des messages a afficher lors de ’exécution
du programme. Lors de ’analyse du fichier on peut notamment afficher les informations de chaque objet traité grace a
la méthode .get_info() dans la fonction maplFCtoBuildingDataModel dans le fichier BIM2Modelica/CoTeTo/Generators/
IFC_MultiZoneBuildings_Modelica/Filters/IfcLib/FilterO1.py.
En ajoutant quelques print de débogage, on remarque que le programme s’arréte lors de la création du maillage d’un mur
ayant les informations suivantes:

{"id ": 75381, 'type’': 'lIfcWallStandardCase ', 'Globalld ': '3RB9qJdjOcJPxaRd_LTXkx "', '
OwnerHistory ": #12=IfcOwnerHistory (#7,#11,%,.ADDED. ,$,%$,%$,1493320357), 'Name': '
WALL', 'Description ': None, 'ObjectType ': None, 'ObjectPlacement ': #75340=
IfcLocalPlacement (#99,#75339), 'Representation ': #75377=IfcProductDefinitionShape ($
.8, (#75365,#75374)), 'Tag': 'DB2C9D13—9ED0—264D—9EE4—6E7TF95761BBB '}

Observation avec Solibri: Les informations obtenues contiennent I'ITD de 1'objet. En ouvrant le fichier IFC avec
Solibri et en utilisant la barre de recherche, on peut retrouver ’objet qui engendre 'erreur.
On s’apergoit alors que l'objet (nommé Mur.0.2 dans le logiciel) n’est non seulement pas visible mais possede des
parametres incohérents (surfaces nulles), parametres qui sont cohérents sur d’autres objets comme le Mur.0.15 (ce qui
élimine I’hypothese d’une erreur liée & Solibri). En parcourant les autres objets, on s’apercoit qu'il existe un autre mur
(Mur.0.8) qui présente les mémes caractéristiques.

Solibri Anywhere - RooftopBuildingaZonesThin

on

wer i g PP QAQAQA K F IS w14 0csF xake L]

RriBw@san o©F (=]

Figure 11: Visualisation de I'objet mal défini avec Solibri

Etude du fichier IFC: Pour comprendre d’ou vient ’erreur il faut donc étudier les fichiers IFC. La méthode consiste a
étudier la définition dans le fichier IFC d’un objet bien défini (par exemple le Mur.0.15 ayant I'ID 0V6E6ruyWeGh4ngRQrNzjX)
pour comprendre comment sont enregistrés les parametres et caractéristiques. Puis de la comparer avec la définition du
Mur.0.2 qui génere l'erreur.

Les définitions qui semblent importantes sont ObjectPlacement et Representation. En partant de ces deux points de
référence, il faut explorer 'arbre en suivant les #XXXX et comprendre ce que représente chaque branche et feuille a I'aide
de la documentation du format IFC2X3.

Il est possible de faire de méme pour les matériaux.
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Figure 12: Légende utilisée dans les arbres IFC

Figure 13: Arbre IFC du placement de 'objet Mur.0.15

Figure 14: Schema du Mur.0.15 avec parametres Solibri

Figure 15: Arbre IFC de la représentation de 1'objet Mur.0.15

Avec un peu de patience et de méthodologie, on remarque que le Mur.0.2 est le support d’une porte qui fait exactement
la taille du mur. Le mur a donc une surface et un volume nuls ce qui rend le maillage impossible. De méme pour le
Mur.0.8.

Cette procédure a permis de mettre en évidence des erreurs dans le fichier RooftopBuilding4Zones_Thin.ifc qui ne
peut donc plus faire office de fichier de référence. Cette hypotheése est confirmée par le fait que le fichier a été commenté
par lauteur de 'outil dans le script pour générer les fichiers de référence.

On peut donc conclure que Uinstallation des biblioteques et de 'outil CoTeTo est correcte et peut étre utilisée pour la
suite du projet.

4.2 Simulation avec Dymola

De premieres simulations peuvent étre faites avec les fichiers Modelica générés grace au logiciel Dymola notamment pour
vérifier si les fichiers de référence créés précédemment sont corrects.

Script de simulation: Il est possible de créer des scripts pour automatiser les simulations. Un script doit étre contenu
dans un fichier ayant ’extension .mos. Le script pour lancer la simulation d’un fichier de UdKB_Unit_Test_Cases est
donné ci-dessous:

Advanced .Define.DAEsolver = false;
cd (" ModelicaModels_reference /IFC2X3/UdKB_Unit_Test_Cases” );

simulateModel (" OneZone” , stopTime=31536000, method="dass|”, resultFile="Simulation/
OneZone");
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5 Matériaux et propriétés thermiques

Sachant que tous les outils fonctionnent, le but est désormais d’apporter des améliorations au projet existant. Afin
d’effectuer les simulations les plus correctes possibles, il faut avoir acces aux propriétés thermiques du batiment.

5.1 Pré-traitement d’un fichier

Il est souhaitable d’utiliser les propriétés thermiques des matériaux utilisés dans la construction. Ces propriétés n’étant
pas toujours disponibles dans les fichiers IFC (Revit ne permet pas d’exporter le modele du batiment au format IFC avec
les propriétés thermiques), il faut les y ajouter ”manuellement”. Une nouvelle fonction provenant de ifc_tools.py est
utilisée a cet effet: add_materials_properties permet d’ajouter des propriétés thermiques enregistrées dans un fichier .json.

def add_materials_properties(ifc_file , materials_file=None, overwrite=False, output=

None) :

ifc = ifcopenshell.open(ifc_file)

with open(materials_file , "r") as read_file:
materials = json.load(read_file)

for mat in ifc.by_type(”I|fcMaterial”):
if mat.Name in materials:

Cp = convert_float_or_none(materials [mat.Name]. get("Cp"))
Bp = convert_float_or_none(materials [mat.Name]. get("Bp"))
Fp = convert_float_or_none(materials [mat.Name].get("Fp"))
k = convert_float_or_none(materials [mat.Name]. get("k"))

ifc.createlfcThermalMaterialProperties(mat, Cp, Bp, Fp, k)

if output:
ifc.write(output)
elif overwrite:
ifc.write(ifc_file)
else:
basename, ext = os.path.splitext(ifc_file)
ifc.write(basename+'—with—materials"+ext)

Figure 16: Version simplifiée de la fonction add_materials_properties

5.2 Création de fichiers de référence

Script de génération: Une fois que les résultats du pré-traitement correspondent a nos attentes, il faut créer des
fichiers de référence. Sachant que l'installation des outils et les fichiers utilisés sont corrects, on peut nous méme créer
les fichiers de référence. Le script Python BIM2Modelica/tests/generate_reference.py permet de générer ces fichiers
dans BIM2Modelica/tests/ModelicaModels_reference. Il fonctionne essentiellement de la méme facon que le précédent
a la seule différence de la gestion des matériaux grace a la fonction add_materials_properties avant le traitement du fichier.
Le fichier .json contenant les matériaux est créé avant de générer les fichiers a ’aide de la fonction createMaterials qui
releve tous les matériaux utilisés dans les fichiers a générer et leur associe des valeurs. Les resultats de la simulation
n’étant pas utilisés a cette étape, des valeurs par défaut sont attribuées a chaque matériau.

def createMaterials(self, ifc_list_files , path):

materials = {}
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default_values = {"k":"1.5", "rho":"2300", "Cp”:"850"}

for file in ifc_list_files:
ifc_file = ifcopenshell.open(parent_folder + " /" 4+ file[0])

all_materials = ifc_file.by_type("|fcMaterial”)
for m in all_materials:
print (m.get_info ())
materials [m.Name] = default_values
with open(path + "/materials.json”, "w') as f:
json .dump(materials, f, indent=4)

Il est envisageable de développer une interface permettant a l'utilisateur de saisir les valeurs des
différentes propriétés thermiques (par exemple dans I'interface graphique interactive du projet Ktirio),
voire un systeme de base de donnée et d’intelligence artificielle qui attriburait les valeurs en fonction
du nom des matériaux.

Remarque

Script de test: On peut aussi créer un script qui permet de tester si les nouveaux fichiers générés coincident avec les
fichiers de référence précédemment créés. De cette fagon, il est possible de repérer si de nouvelles modifications dans
Poutil de génération automatique de modeles alterent les fonctionnalités concernant I’ajout des matériaux.

Conversion
IfcOpenShell
(Analyse IFC)
Fichiers Modelica
BuildingSystems de référence
(Template) .o
CoTeTo

(Générateur de fichier)

P t:|es " CoTeTo Modifié
Y ”rétrocompatible”

Conversion
Architecture de référence Fichiers Modelica
ife IfcOpenShell mo
(Analyse TFC)
BuildingSystems
(Template)
Ar.c/hl/tecture (.at Fichiers Modelica Simulation
propriétés thermiques CoTeTo Modifié o o

-ifc (Générateur de fichier)

Figure 17: Protocole de génération des fichiers
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Le script BIM2Modelica/tests/check_ifc2Modelica.py génere de nouveaux fichiers dans un dossier temporaire puis
compare chaque fichier généré avec le fichier référence qui lui est associé grace a la fonction compareFiles.

Script de simulation: Le script de simulation précédent peut étre facilement adapté pour fonctionner avec les nouveaux
fichiers.
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6 Outils d’analyse et de diagnostic

Les matériaux sont désormais traités correctement. Cependant, un nouveau jeu de fichiers IFC révele de nouvelles failles
et de possibles améliorations.

6.1 Conversion et simulation des fichiers

Script Python: La premiere étape pour tester cet ensemble de fichiers est la conversion de IFC vers Modelica. Pour
cela, on utilise un script Python tres similaire au script qui génere les fichiers de référence.

A ce stade la fonction config du module test_util.py doit étre adaptée afin de créer une copie du fichier Package.inf
en modifiant non seulement ModelicaLibPath et ModelicaMosPath mais aussi ’option calcHygroThermal. Cette option,
activée par défaut, doit étre mise en position off. Sans cette modification, la majorité des fichiers Modelica générés ne
peuvent pas étre simulés dans Dymola.

def config(ModelicaLibPath, ModelicaMosPath, outputfile="tmp/Package.inf",
calcHygroThermal="0off"):
if calcHygroThermal = "on":
for line in fileinput.input([configfile], inplace=True):
if line.strip().startswith("calcHygroThermal”):

line = "calcHygroThermal = on\n"
sys.stdout.write (line)
elif calcHygroThermal = "off":

for line in fileinput.input([configfile], inplace=True):
if line.strip().startswith("calcHygroThermal”):
line = "calcHygroThermal = off\n"
sys.stdout.write (line)
else:
print (""" + calcHygroThermal + """ +
" is not an option for calcHygroThermal. Default option 'on' is used
instead .")

Figure 18: Extrait de la fonction config permettant de désactiver 'option calcHygroThermal

Script Dymola: De méme, un script Modelica peut étre écrit pour automatiser la simulation des fichiers Modelica qui

viennent d’étre créés. ) o ) R o ) . ) )
Dans les deux scripts précédents il faut étre vigilent au chemin d’acces de chaque fichier. Suivant

s’ils sont utiles et s’ils ont pu étre simulés, les fichiers sont classés dans deux répertoires distincts
no_need_to_validate et validated.

Remarque

Résultats: Tous les fichiers a I’exception de EnergyLabB665-with-materials.ifc ont pu étre simulés avec Dymola.
Le fichier problématique renvoie de nombreuses erreurs lors de la simulation. Lors de la génération du fichier Modelica,
un message indique qu’un mur est en collision avec un espace et n’est donc pas traité. On remarque effectivement qu’il
manque un mur dans le fichier Modelica.

6.2 Outil de diagnostic

Des outils peuvent étre créés afin de faciliter la détection des erreurs dans la conversion.

Analyse ”manuelle” de fichiers IFC: Dans le cas du fichier EnergyLabB665-with-materials.ifc, 'identifiant IFC
du mur non traité est affiché dans le message d’avertissement. Dans le fichier Modelica, aucun mur n’a cet identifiant. En
ouvrant le fichier IFC avec Solibri on peut visualiser le mur en question et ainsi repérer a quel espace il est rattaché. On
peut aussi facilement accéder a 'identifiant de ’espace et ainsi retrouver ’espace dans le fichier Modelica. On s’apercgoit
alors que le nombre de murs liés a cet espace est erroné.
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Analyse de fichiers IFC: IL’outil AnalysisTool (DataAnalysis/ifc_tools/IfcAnalysis/analysis_tool.py) a été
créé dans le but de faciliter le maniement du contenu des fichiers IFC.

Cet outil permet d’analyser un fichier IFC par type (IfcBuilding, IfcZone, IfcSpace, IfcSlab, IfcWall, IfcDoor, IfcWindow)
et d’enregistrer les informations importantes et accessibles dans un dictionnaire.

Les informations récupérées (lorsqu’elles sont disponibles) sont les coordonnées de ’objet, les propriétés stockées dans
BaseQuantities, les matériaux et le lien avec d’autres objets.

def analyseElement(self, element_type):
elements = self.ifc_file.by_type(element_type)
for element in elements:
if element_type != "lIfcZone":

local_coordinates = ifcopenshell.util.placement.get_local_placement(element
.ObjectPlacement)[0:3,3]

quantities = ifcopenshell.util.element.get_psets(element)
base_quantities = {}
try:
base_quantities = quantities[ BaseQuantities ']
bg_indicator = True
except:
print(element. Globalld + " does not have BaseQuantities”)
bg_indicator = False
if element_type != "IfcBuilding” and element_type != "IfcZone” and element_type
I= "|fcSpace”:
materials = self.findMaterials(element)
if element_type = " IfcWall":
self.analyseWall(element, local_coordinates, bg_indicator, base_quantities ,

materials)

Figure 19: Méthode analyseElement commune a tous les types d’éléments
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def analyseWall(self, element, local_coordinates, bq-indicator, base_quantities,
materials):
if bg_indicator:
self.walls[element. Globalld] = [local_coordinates ,
(base_quantities|[ 'Length'], base_quantities['
Width "], base_quantities|[ Height']),
base_quantities[ GrossFootprintArea'],
base_quantities [ GrossVolume '],
materials ,
False # Set to true when saved in file

else:
self.walls[element. Globalld] = [local_coordinates ,

"o

’
"o

'
non

'

materials ,
False # Set to true when saved in file

]

Figure 20: Méthode analyseWall permettant d’enregistrer les informations relatives a un mur

Diagnostic de fichiers IFC: A Paide de Doutil AnalysisTool et du module Xlsxwriter, il est possible de créer un outil
de diagnostic rapide. Les résultats de I’analyse avec AnalysisTool sous forme de dictionnaires peuvent étre écrits dans un
tableau, les rendant facilement lisibles.
Pour chaque fichier IFC analysé, un fichier xlsx est créé. Ce fichier contient une page par type d’élément présent
(IfcBuilding, IfcZone, IfcSpace, IfcSlab, IfcWall, IfcDoor, IfcWindow).

Par exemple, grace aux résultats présentés en annexe (voir section [§8) page 7 il est facile de voir que le fichier
ACJasmin.ifc contient un seul IfcBuilding, aucun IfcZone (pas de feuille IfcZone et colone Zone grisée), dix IfcSpace et
cinq IfcSlab.
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Figure 21: Extrait du résultat du diagnostic du fichier ACJasmin.ifc

De méme, on constate que le batiment dans le fichier TwoZones.ifc contient deux IfcZones. La premieére zone contient
un IfcSpace et la seconde en contient deux. Les six murs présents dans le fichier ne sont associés a aucun espace.
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Figure 22: Extrait du résultat du diagnostic du fichier TwoZones.ifc

Comparaison de fichiers IFC: Il peut aussi étre utile de comparer deux fichiers IFC, notamment deux fichiers
provenant du méme projet Revit ayant subit de légeres modifications: options d’exportation différentes, modification des
zones et espaces, ajout des propriétés des matériaux.

Cette comparaison permet alors de repérer quelles options d’exportation sont nécessaires ou si 'ajout des matériaux ne
modifie pas d’autres propriétés.

Dans I’exemple suivant, les fichiers OneZone.ifc et ThreeZones.ifc sont issus du méme projet Revit mais exportés avec
différentes zones.

OneZone_ThreeZones.xlsx - LibreOffice Calc _ o x
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Figure 23: Résultat de la comparaison entre les fichiers OneZone.ifc et ThreeZones.ifc
Remarque || La gestion des pages et la mise en page peut étre modifiée pour offrir plus de lisibilité suivant les besoins.

Comparaison de fichiers IFC et Modelica: Un outil pour comparer le contenu d’un fichier IFC et le contenu d’un
fichier Modelica permet de déceler les erreurs lors de la conversion en fichier Modelica.
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7 Etude et amélioration de I’outil de génération automatique de modeles

Grace aux outils d’analyse et de comparaison, il est possible de déceler les erreurs lors de la conversion. Ces outils et les
pytests automatiques permettront de définir si une modification effectuée dans BIM2Modelica est une dégradation ou une
amélioration.

7.1 Fonctionnement

Le fonctionnement du générateur IFC_MultiZoneBuildings_Modelica utilisé dans BIM2Modelica utilise la fonction
maplFCtoBuildingDataModel du fichier BIM2Modelica/CoTeTo_Generators/IFC_MultiZoneBuildings_Modelica/Filters/
FilterO1.py pour récupérer toutes les informations importantes dans le fichier IFC et les stocker sous la forme d’objets
définis dans BIM2Modelica/CoTeTo_Generators/IFC_MultiZoneBuildings_Modelica/Filters/IfcLib/DataClasses.
py- Ces informations sont ensuite regroupées gréace a la fonction getGeneratorData qui renvoie un dictionnaire ayant la
structure suivante, ou les valeurs sont des listes d’objets:

{'materials ' : materials ,
"constructions ':constructions ,
"zones ' :zones,
"elementsOpaque ' :elementsOpaque
"elementsTransparent ':elementsTransparent ,
"elementsDoor ' :elementsDoor ,
"conEleZon '":conEleZon,
"conEleAmb ' :conEleAmb ,
"conEleSol ' :conEleSol ,
"buildingSystem ': buildingSystem }

Figure 24: Dictionnaire contenant les informations & écrire dans le fichier Modelica

7.2 Blacklist

Par défaut, CoTeTo/BIM2Modelica détecte les collisions entre objets. En effet, ’étude des fichiers FilterO1.py et
Ifc2x3Lib.py révele lexistence d'une blacklist. Lors de la collecte des informations sur le batiment, la géométrie des
éléments est analysée et les collisions sont détectées a 1’aide d’outils Python-OCC. Par exemple, les IfcSlab et les IfcWall
ayant plus de 90% de leur volume en commun avec un espace sont considérés comme des murs intérieurs négligeables pour
la simulation thermique et ceux ayant plus de 1% de leur volume en collision sont considérés comme mal définis.

for w in all_walls:
if w.Globalld in Walllnfo.keys():

wall_shape = ifcopenshell.geom.create_shape(settings , w).geometry

OCC. Core . BRepGProp. brepgprop_VolumeProperties(wall_shape , props)

wall_volume = props.Mass|()

cmn_shape, area, BuilderCanWork = commonFace_andArea(wall_shape, space_volume)

OCC. Core . BRepGProp. brepgprop_VolumeProperties(cmn_shape, props)

if props.Mass() > wall_volume x 0.9:
black_list_walls.append(w. Globalld)

elif props.Mass() > 0.01:
ToBeRepairWall.append(w. Globalld)
black_list_walls.append(w. Globalld)

Figure 25: Extrait de la fonction RelatedElementsWalls dans Ifc2x3Lib

Dans la version du générateur utilisée, la liste ToBeRepairWall n’est pas réutilisée par la suite. C’est a

dire que les murs en collision avec un espace ne sont pas corrigés.
Dans le cas du fichier EnergyLabB665-with-materials.ifc vu précédemment, un message d’avertissement indique

qu’un mur est en collision avec un espace et qu’il est ignoré pour le reste du processus. Ce qui signifie que le fichier
Modelica créé ne contient pas la véritable structure du batiment et donnerait lieu a des résultats de simulation faux s’il
pouvait étre simulé.

Remarque ‘ ‘
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8 Conclusion

La simulation thermique de batiment s’inscrit dans les initiatives concretes et actuelles pour lutter contre le changement
climatique en favorisant le respect de 'environnement. Les pertes énergétiques peuvent étre décelées et évaluées avant la
construction ou dans l'objectif d’entreprendre la rénovation d’un batiment.

Les capacités (notamment matérielles) de calcul actuelles permettent de réaliser ce genre de simulation. Cependant, il
est difficile de mettre au point un programme suffisamment flexible et robuste permettant de simuler des architectures
variées, réalisées avec de nombreux matériaux et concues avec des logiciels différents.

De méme que des travaux de recherche concernant les calculs des divers parametres thermiques et météorologiques au
ceeur de la simulation sont nécessaires, des travaux de recherche sont indispensables afin d’utiliser pleinement les données
matérielles d'un batiment. Cela consiste & extraire correctement 1’ensemble des données géométriques, vérifier ou ajouter
les informations concernant les parametres thermiques (zones thermiques et propriétés des matériaux) et créer un fichier
utilisable pour la simulation sans perdre d’information.

Ce travail requiert, en plus d’une bonne compréhension du probleme, des compétences techniques dans différents
domaines. Il est impératif de faire le lien entre les objets visualisés dans les logiciels de CAO et les données codées dans les
fichiers grace a une bonne maitrise des logiciels et des langages de programmations utilisés. Il faut également faire preuve
de patiente et d’une grande rigueur pour comprendre tous les enjeux, appréhender les difficultés rencontrées et trouver les
solutions possibles. Le tout doit étre réalisé en conservant un espace de travail partagé organisé et compréhensible pour
tous et en communicant les résultats a ’ensemble des membres de I’équipe de recherche.
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Annexes

Installation des outils

Anaconda: Sous Windows, un fichier exécutable est disponible sur la page de téléchargement[I§].
Sous Linux, un fichier shell peut étre téléchargé et exécuté dans un terminal sur la page de téléchargement|Ig].

IfcOpenShell et Python-OCC: La version 0.6.0b0 d’IfcOpenShell et la version 7.5.1 de Python-OCC ont été installées
sur un environnement Conda reposant sur la version 3.8.13 de Python en utilisant les commandes:

conda install —c conda—forge ifcopenshell
conda install —c conda—forge/label /cf202003 ifcopenshell

conda install —c conda—forge pythonocc—core
conda install —c conda—forge/label/cf202003 pythonocc—core

CoTeTo: L’outil Code Templating Tool peut étre téléchargé directement depuis le dépot GitHub[7]. 1l existe trois
fagons d’utiliser CoTeTo: a 'aide de l'interface graphique, en ligne de commande ou avec un script Python.

Interface graphique: Il faut lancer le script BIM2Modelica/CoTeTo/scripts/CoTeTo-gui.py. L’interface permet
de choisir le générateur, le fichier IFC a convertir et le chemin d’acces au fichier généré. On peut suivre I’évolution du
processus et lire les éventuels messages d’erreur dans l'onglet Messages.

CoTeTo GUI | Version: 1.0 _ o ®
Generators | Dataloaders = Messages

Example01Mako:1.0 " N o .

Example02Jinjaz:1.0 IFC_Multiz _ a - version 0.2
Example03CustomEntries:1.0

Example04Multioutput:1.0 Author

Example05CustomLoaders::1.0
Example06PostExec:1.0
Example07NumberLines::1.0
Example08Zip::1.0
ExamplesoJsonFluid:1.0

christoph Nytsch-Geusen
Description
generator for Modelica building models based on IFC data

Path

[h fabi Modelica/CoTeTo Generators,
IFC_MultiZoneBuildings Modelica

Data Loader

Requires IFCFile, version 0.1..2.0
Found version 1.

Templates

.mo: PhysicalModel.mot
_StateVariables.cs: StateVariables.unt
_BuildingModeL.cs: BuildingModel.unt
Python Filter

e = Filter01.filter01

Data URIs: | /home/fabien/stage/BIM2Modelica/IFC/IFC2X3/UdKB_Unit_Test_Cases/OneZone.ifc Generate

Output: | /homej/fabien/stage/BIM2Modelica/ModelicaModels/test ...|| V/Open output

Figure 26: Interface graphique de CoTeTo

Lignes de commande: Il suffit d’utiliser les commandes suivantes pour utiliser CoTeTo dans un terminal. La
premiere commande affiche I'aide, la deuxieme permet de générer un fichier Modelica a partir d’un fichier IFC et la
dernieére commande permet d’effectuer une comparaison grossiere entre le résultat attendu et le résultat obtenu (en
ignorant les 277 premiers octets, on évite la ligne dans I’entéte du fichier contenant ’heure et la date de création du
fichier, cependant la premiere ligne, affichant les paquets utilés, n’est pas vérifiée).

python CoTeTo—cli.py —help
python CoTeTo—cli.py —p ../ Generators —g ? —o [input_file] [output_file] A VERIFIER
cmp —| —b —i 277 [filel] [file2]

Il faut cependant étre vigilant et modifier le fichier CoTeTo/CoTeTo/Generators/IFC_MultiZoneBuilding Modelica/
Package.inf pour obtenir le bon entéte et pied de page (adapter ModelicaLibPath et ModelicaMosPath).

Scripts Python: CoTeTo est aussi utilisable en tant que module Python. Voici un exemple de script utilisé pour
générer les fichiers avec CoTeTo.
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import sys

import os

os.mkdir('./generatedCode ")
os.chdir('./generatedCode ")
sys.path.append(”../../../../CoTeTo")
from CoTeTo. Controller import Controller

con = Controller ()
gen = con.generators|[ ' IFC_MultiZoneBuildings_Modelica::0.2 "]
files = [('OneZone.ifc ', 'OneZone') ,('TwoZones.ifc ', TwoZones')]

for f in files:
gen.execute(( ../ '+f[0], ), f[1])

La aussi il faut étre vigilant et modifier le fichier CoTeTo/CoTeTo/Generators/IFC_MultiZoneBuilding Modelica/
Package. inf pour obtenir le bon entéte et pied de page (adapter ModelicaLibPath et ModelicaMosPath). Une solution &
ce probleme est proposée dans le script pour générer les fichiers de référence.

Dymola: La procédure d’installation du logiel se fait en exécutant les lignes de commandes suivantes:

In /usr/lib/x86_64—linux—gnu/libevent —2.1.s0.7 /usr/lib/x86_64—linux—gnu/libevent —2.0.
so.b5

wget —O Dymola.zip https://www.dropbox.com/s/picl6nfu9d9vy63/Dymola_2021. AM_CAT_Dymola.
Linux64.1—-1.zip?dI=0 &&\

unzip —j Dymola.zip AM_CAT_Dymola.Linux64/1/linux_x86_64/dymola—2021.1—1.x86_64 .rpm &&\

alien —k dymola—2021.1—1.x86_64.rpm &&\

apt install ./dymola_2021.1—1_amd64.deb &&\

rm dymola—2021.1—1.x86_64 .rpm dymola_2021.1—1_amd64.deb Dymola. zip

dymola—2021—x86_64

Il faut ensuite activer la licence. Pour cela, naviguer dans les menus tools, licence, set-up, set-up. Dans le cadre server
name saisir: gaya.math.unistra.fr
La procédure pour lancer une simulation est la suivante:

e Charger la librairie BuildingSystems (version master?) en navigant dans le menu File »Open »Load. Naviguer dans
BuildingSystmes/BuildingSystems et charger le fichier package.mo.

e Ouvrir le fichier Modelica & simuler en navigant dans le menu File Open >Open.

e Lancer la simulation depuis 'onglet Simulation »Simulate.

Le menu File >Working Directory permet de définir I’emplacement ou sont stockés les fichiers de

Remarque H . 3
simulation.
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Figure 27: Interface grahique du logiciel Dymola

Solibri:

—o
Z, windows -

Sous Windows, le fichier exécutable pour installer Solibri est accessible apres avoir suivi la procédure

d’enregistrement[I9]. Pour utiliser Solibri dans une distribution Linux, il faut utiliser WineHQ[20].
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Figure 29: Résultat du diagnostic du fichier ACJasmin.ifc
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Figure 30: Résultat du diagnostic du fichier TwoZones.ifc
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